
Intella 1.1
User Manual

Version: 1.1.1



Vound 
© 2008-2009 Vound LLC. All rights reserved. 

Under the copyright laws, this manual may not 
be copied, in whole or in part, without the 
written consent of Vound LLC. Your rights to the 
software are governed by the accompanying 
software license agreement.

The Vound logo is a trademark of Vound LLC. 
Use of the Vound logo for commercial purposes 
without the prior written consent of Vound may 
constitute trademark infringement and unfair 
competition in violation of federal and state 
laws. 

Every effort has been made to ensure that the 
information in this manual is accurate. Vound 
LLC is not responsible for printing or clerical 
errors. 

Note:  Because Vound frequently releases new 
versions and updates to its system software, 
applications, and Internet sites, images shown in 
this manual may be slightly different from what 
you see on your screen. 

Vound LLC
Delaware, USA
www.vound-software.com 

Other company and product names mentioned 
herein are trademarks of their respective 
companies. Mention of third-party products is 
for informational purposes only and 
constitutes neither an endorsement nor a 
recommendation. Vound assumes no 
responsibility with regard to the performance 
or use of these products.

page 2 | Intella  | © 2008-2009  Vound



Contents
1. Preface....................................................................................................................................7

Documentation Conventions......................................................................................... 7
2. An introduction to Intella...................................................................................................9

Key benefits...................................................................................................................... 10
Supported file formats................................................................................................... 10
Supported sources..........................................................................................................11
Supported platforms.......................................................................................................11
Version history.................................................................................................................11
Feedback........................................................................................................................... 12

3. Installing and running........................................................................................................ 13
System requirements......................................................................................................13
Downloading Intella........................................................................................................13
Required software...........................................................................................................13
Trial license....................................................................................................................... 14
Installation.........................................................................................................................15
Starting Intella.................................................................................................................. 15
Uninstalling Intella........................................................................................................... 15

4. Configuring Intella............................................................................................................. 16
Lotus Notes configuration............................................................................................ 16

Validate Lotus Notes installation...........................................................................16
Initialise Lotus Notes installation.......................................................................... 17
What to do if Lotus Notes initialisation fails?.................................................... 17

5. Managing cases................................................................................................................... 22
Creating a new case........................................................................................................22
Opening an existing case............................................................................................... 23
Removing an old case.....................................................................................................23

6. Overview of the Intella interface................................................................................... 24
7. Sources................................................................................................................................ 25

Source types.....................................................................................................................25
Adding sources................................................................................................................ 25

Adding a Folder source........................................................................................... 27
Adding a MS Outlook file (PST, OST) source.....................................................28
Adding a MS Outlook Express DBX file source................................................ 29
Adding a Lotus Notes NSF file source.................................................................30
Adding an IMAP account source........................................................................... 30
Last steps in a source type definition...................................................................31

page 3 | Intella  | © 2008-2009  Vound



Indexing, refreshing and re-indexing sources............................................................ 33
Indexing.......................................................................................................................33
Refreshing................................................................................................................... 34
Re-indexing................................................................................................................ 34

Editing sources.................................................................................................................35
Selecting sources............................................................................................................. 36
Shortcuts...........................................................................................................................37

8. Searching..............................................................................................................................38
Search options................................................................................................................. 38
Limiting the search scope..............................................................................................39
Search query syntax....................................................................................................... 39

Use of multiple terms (AND and OR operator)...............................................39
Minus sign (NOT operator)................................................................................... 40
Phrase search.............................................................................................................40
Grouping.....................................................................................................................40
Single and multiple character wildcard searches............................................... 41
Fuzzy search...............................................................................................................41
Proximity search....................................................................................................... 41
Field-specific search..................................................................................................41

9. Using facets......................................................................................................................... 43
Keyword Suggestions......................................................................................................43
Tags.....................................................................................................................................44
MD5 hash..........................................................................................................................44
Source................................................................................................................................44
Location.............................................................................................................................45
Date & time...................................................................................................................... 45
Type.................................................................................................................................... 46
People................................................................................................................................ 46
Language............................................................................................................................46
Size .................................................................................................................................... 47

10. Cluster Map panel........................................................................................................... 48
Understanding a Cluster Map.......................................................................................48
Working with the Cluster Map.................................................................................... 49

Removing result sets................................................................................................49
Opening a search result.......................................................................................... 50
Export cluster map...................................................................................................50
Using significant terms.............................................................................................51

Options..............................................................................................................................51
11. Details panel..................................................................................................................... 53

page 4 | Intella  | © 2008-2009  Vound



Table view......................................................................................................................... 53
Adding and removing columns...............................................................................54
Reorganizing table columns....................................................................................55
Sorting the list........................................................................................................... 55
Deduplicating results................................................................................................56
Showing a conversation...........................................................................................56
Showing parent e-mail............................................................................................. 56

List view............................................................................................................................ 56
Thumbnails view..............................................................................................................57

12.Tagging................................................................................................................................ 58
13. Exporting result list........................................................................................................ 59

Exporting a single result................................................................................................ 60
14. Viewing results..................................................................................................................61

Overview of the viewer.................................................................................................61
Tabs.................................................................................................................................... 62
Buttons.............................................................................................................................. 63

15. Preferences....................................................................................................................... 64
General..............................................................................................................................64

Display splash screen............................................................................................... 64
Animate changes....................................................................................................... 65
Maximum duration................................................................................................... 65
Scale to fit window...................................................................................................65
Number of results per page................................................................................... 65
Thumbnail minimum size........................................................................................ 65

MS Outlook...................................................................................................................... 65
Preferred Outlook crawler.....................................................................................65
MS Outlook connector........................................................................................... 66

IBM Lotus Notes............................................................................................................. 66
16. Menu and keyboard shortcuts......................................................................................67

Main Menu........................................................................................................................ 67
File................................................................................................................................67
Sources........................................................................................................................67
View............................................................................................................................. 67
Export......................................................................................................................... 68
Help............................................................................................................................. 69

Keyboard shortcuts........................................................................................................ 69
17. Frequently Asked Questions.........................................................................................70

Where are Intella's data files located?..................................................................70
Where can I find Intella log files?.......................................................................... 70

page 5 | Intella  | © 2008-2009  Vound



How is a file type determined?.............................................................................. 70
Why are some characters ignored in search queries?......................................70
Why can't I index a PST file when I use the Rdo crawler?..............................71
What to do with a License Error?........................................................................ 71
What to do with "Code 27 HASP _TS_ DETECTED"?.................................. 71
What you should know about the Intella trial license?.................................... 72

page 6 | Intella  | © 2008-2009  Vound



1. Preface

When you need to explore IMAP e-mail accounts, Microsoft Outlook PST 
and OST files, Microsoft Outlook Express DBX files, Lotus Notes NSF files 
and file systems, Intella is the state of the art e-mail investigation and 
eDiscovery tool to be used. Its bird's eye view guides you to relevant 
evidence in little time.
 
Intella requires limited training time. This manual will help you learn and 
make full use of all the features.

Documentation Conventions

The following section introduces you to conventions used throughout the 
Intella documentation. 

Menu Functions 

For functions that can be reached through menus, the different menu levels 
are illustrated as follows:  Menu > Menu entry. 

Important Entries 

Some text will be shown as follows:
 

Important:  Important information on Intella. 

These entries discuss a key concept or technical information that should, or 
must, be followed or taken into account. Please pay special attention to 
these entries.

Notes 

Some sections provide additional information that will assist your use of 
Intella. These are displayed as shown below: 
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Note:  Information on function or parameter. 

Keyboard Shortcuts

Some Intella functions can be activated or accessed through keyboard 
shortcuts. They are shown as follows: CTRL+E

Tips 

A number of shortcuts, alternative methods, or general working tips are 
included throughout the documentation. These may help your workflow, or 
provide additional information on other uses of functions. Tips are shown 
as below: 

Tip:  Information on Intella.
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2. An introduction to 
Intella

Intella is an instrument for e-mail investigation and eDiscovery. It helps 
you search and explore information stored on your computer, network 
disks, in e-mail boxes and PST, OST and NSF files. Intella is being used by 
Law Enforcement, Legal and regulatory bodies to do all of the above. 

Intella indexes all places where you expect valuable information and 
provides powerful means for retrieving that information. The important 
advantage over similar tools is that Intella presents the search results using 
facets and Cluster Maps. Facets allow you to find items based on more than 
just keywords and the visualization provided by the Cluster Maps allows 
you to see how files and e-mails are related to your query.

The birds-eye view helps you gain insight in information that is available on 
combinations of keywords. In each step of your search it shows the number 
of e-mails or files that match your search (and of course a link to the 
e-mails and files themselves) so that you can effectively zoom in to find 
what you are looking for.

Setting up Intella on your computer takes little time. Install the software, 
define the sources to search and explore and let Intella index the sources.

Searching with Intella is also easy. Start as if you are using a familiar search 
engine by entering a search term, or choose any value from the information 
facets. Let Intella help you to refine your question with a list of suggested 
refinements. Use Cluster Maps to get a comprehensive overview of the 
available information.
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Key benefits

• Visualization of search results provides you with deeper insight. See 
how  files and e-mails relate to parts of your query.

• Facets, like Type, Date and Language, help you to drill down to the 
wanted information and to focus on the information you need.

• Search e-mail attachments and archives, like zip files.

• Searching is simple and requires very little training. The Intella 
Case Manager helps you organize your work efficiently.

• Export the search results for later use and creation of reports.

Supported file formats

Intella can search in the contents and metadata of the following file 
formats:

• Plain text
• HTML
• XML
• RTF
• PDF
• MS Office: Word, Excel, Powerpoint, Visio, including support for 

the OpenXML formats introduced in MS Office 2007
• MS Works
• MS Publisher
• OpenOffice: both OpenDocument as well as legacy 

OpenOffice/StarOffice formats
• Corel Office: WordPerfect, Quattro, Presentations
• saved mails (.eml files)
• Archives: zip, gzip, bzip2, tar, rar
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Supported sources

• Local and network file systems
• IMAP e-mail accounts
• Microsoft Outlook PST and OST files
• Lotus Notes NSF files

Supported platforms

Intella is currently only available for Windows.

For detailed instructions about installation and running Intella, please read 
the “Installing and running” section.

Version history

Intella 1.1 has the following major improvements:

• Better performance and stability with new PST and OST crawler
• Support for MS Outlook Express .dbx files
• Support for RAR archives
• Preview shows extracted text with search term highlighting
• Image extraction from Word, Excel, Powerpoint and OpenXML
• Thumbnail viewer as an alternative for the table and list views
• Support for Asian languages
• Search on arbitrary date ranges in the Date & Time facet
• Support for queries that start with a wildcard ('*' or '?')
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Feedback

We take great care in providing our customers with a pleasant experience, 
and therefore greatly value your feedback. You can contact us by the 
following means:

• E-mail: support@vound-software.com

• You can also use the form on 
http://www.vound-software.com/
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3. Installing and running

System requirements

Intella is supported on the following operating systems:

• Windows: 2000, 2003, XP, Vista

Minimal hardware configuration:

• Intel Pentium 4, 2 GHz
• 1 GB RAM

Recommended hardware configuration:

• Intel Core Duo
• 2 GB RAM

Downloading Intella

You can download Intella from the download page on the Vound website: 
http://www.vound-software.com/

Before you enter the download page, you are asked for some personal 
details. This information help us in understanding our user community and 
lets us improve our software accordingly.

Required software

• In order to correctly index PST and OST files, Microsoft Office 
2007 is no longer required to be installed on the computer that 
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runs Intella. If you want to use the old PST crawler (option in 
File > Preferences), then Microsoft Office 2007 should be installed 
on your computer.

• In order to index NSF files, Lotus Notes 8.0 or higher is required.

Trial license

Notes on the trial license of the software you have downloaded:

• The evaluation version runs under a HASP Software License, that 
gives you the opportunity to use Intella for 14 days.

• If you would like to continue using Intella after this period, you will 
need to buy a license. After buying the license you will receive a 
USB dongle. With the dongle you can continue using the version 
you already installed. 

• We cannot extend the 14 days evaluation peiod. The only way to 
continue using Intella will be to use a dongle.

• The evaluation version will not work in VMware without a dongle.

• The Intella evaluation version will not run over a RDP connection 
without the dongle.

• All other HASP protected software, e.g. EnCase and ASR data, must 
be closed when installing Intella.

• If you change the clock on your system the license will 
automatically expire. You will need a dongle to be able to use 
Intella after that.
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Installation

To install Intella:

1. Double-click on the downloaded .exe file to launch the installer. 

2. Accept the license. 

3. Enter the locations to store the application files and shortcuts or 
accept the default settings. The default location is: C\Program 
Files\Vound\Intella\. All files are extracted to the location of your 
choice and an Intella shortcut is (optionally) placed on your 
desktop and in your Start menu.

The installation can be used for 14 days. After this period usage can only be 
continued when you buy a license.

Starting Intella

The application folder contains an executable called "Intella.exe" that can 
be used to launch the application. The desktop and menu shortcuts also 
start this executable.

Uninstalling Intella

The Intella application folder contains an executable called “Uninstall.exe” 
that can be used to uninstall Intella. You can also start this executable with 
the menu shortcut in the Vound > Intella Windows program group.
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4. Configuring Intella

Lotus Notes configuration

Most source types do not require configuration, except Lotus Notes NSF 
files. This section describes the steps you have to take in order to prepare 
Intella for the addition of Lotus Notes NSF files. 

This is necessary because  Intella needs the Lotus Notes executable to index 
Lotus Notes NSF files. Information on where to find the executable needs to 
be made available to Intella in the “IBM Lotus Notes” tab in the Preferences 
panel.

Important:  Please ensure you are using the latest version of Lotus Notes 8.x or 
higher. 

Validate Lotus Notes installation
1. Go to File > Preferences and select the “IBM Lotus Notes” tab.

2. Press Validate to check if Intella can detect the Lotus Notes 
installation and if Lotus Notes is in the system PATH environment 
variable. 

If this is not the case you will get the following feedback:
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Initialise Lotus Notes installation
If the validation of the Lotus Notes installation fails, please go through the 
following steps.

1. Start Intella and open a new case. When the main Intella window 
opens, cancel the Add New Source Wizard.

2. Go to File > Preferences and select the "IBM Lotus Notes" tab.

3. Press Browse and select the path to the Lotus Notes directory. Press 
Apply.

Tip:  The default installation directories for Lotus Notes are...

- Version 7.x: C:\Program Files\Lotus\Notes

- Version 8.x: C:\Program Files\IBM\Lotus\Notes

4. Restart Intella and go to File > Preferences and select the "IBM 
Lotus Notes" tab again.

5. Press “Add to PATH”.

6. Now restart your computer. Open Intella and check if the Lotus 
Notes installation is detected.

What to do if Lotus Notes initialisation fails?
If the steps in the previous section fail to validate the Lotus Notes 
installation, please do the following.

1. Close Intella.
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2. Right click on My Computer > Properties. In the System Properties 
dialog, select the "Advanced" tab and press Environmental 
Variables.
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3. In  both the "User variables for <username>" and  "System 
variables" section press Edit.

4. In the Edit System Variable dialog, add the path to Lotus Notes 
installation directory.

Please ensure you have the correct path of the Lotus Notes 
directory.

5. In the Environment Variables dialog, check the path to the Lotus 
Notes installation directory in both sections. If they are right, press 
OK. If they are not right, go back to step 3.
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6. Restart your computer.

7. Validate that that last steps did add Lotus Notes to the PATH by 
opening a Command window and typing "PATH" at the command 
prompt.

8. If Lotus Notes installation directory is now in your PATH, please 
launch Intella and check if the Lotus Notes installation directory is 
validated by Intella. Go to File > Preferences and select the "IBM 
Lotus Notes" tab.
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Should the problem persist please contact support@vound-
software.com.
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5. Managing cases

A case is a collection of sources that can be searched by Intella. Use cases to 
organize your work.

When you start Intella, the Intella Case Manager shows up. Here you can 
select existing cases, define new cases and remove old ones.

Creating a new case

In order to create a new case, select “New...” in the Case Manager window. 
The Create New Case dialog shows up. Give the case a name, enter an 
optional description and select a place (Data folder) where you want to 
store data that belongs to this case.

Note: The default location is: C:\Documents and 
Setting\<username>\Application Data\Intella\cases\
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Note:  You do not enter the data source to be indexed by Intella here. You can 
define data sources after opening a case.

Opening an existing case

In the Case Manager window, select a recent case from the list and press 
“Open”. Or, use “Browse...” and browse to the folder containing a case you 
want to open.

Removing an old case

In the Case Manager window, use “Remove” to remove a case that you 
selected from the list. You will be asked to confirm the removal.

The consequence of removing a case is that the indexes created for the case 
are removed.
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6. Overview of the Intella 
interface
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7. Sources

Sources are one of the key concepts of Intella. They represent the locations 
where items, like e-mails, documents and video files can be found. Sources 
are explicitly defined by the user, providing full control over what 
information is being searched.

Source types

Intella distinguishes between various type of sources:

• Folder sources represent folders on a local hard disk or on a 
shared/network drive.

• MS Outlook file (PST, OST) sources represent e-mail folders in 
Microsoft Outlook.

• MS Outlook Express DBX file sources represents e-mail folders 
in Microsoft Outlook Express.

• Lotus Notes NSF file sources represent e-mail folders in Lotus 
Notes.

• IMAP account sources represent one or more e-mail folders in a 
IMAP e-mail account.

Adding sources

Adding sources to Intella is done with the “Add New Source” wizard. You 
can start this wizard in three ways:
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• Select “Add New...” from the Sources menu. Sources > Add New ...

• Select “Add New...” in the Sources panel in the lower left of the 
main window.

• Use CTRL+N.
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After addition, the source is added to the list in the Sources panel. Each 
source has a check box behind its name, indicating whether the source is  
currently used for queries. Uncheck this box if you temporarily do not want 
to receive any results from this source.

Adding a Folder source
Follow these steps to add a Folder source to Intella:

1. Source Type
Start the Add New Source wizard from the menu: Sources > 
Add New...
Select Folder and press Next
As a result, a folder tree is shown.

2. Specify Folder
From the tree select the folder whose contents you want to index or 
enter its name in the text field above the tree. Files in the selected 
folder will be indexed. When the “Include subfolders” checkbox is 
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marked, files in subfolders (and subsubfolders, etc.) will also be 
indexed. When the “Include hidden folders and files” checkbox is 
marked, hidden files and folders will  be indexed. 

Note:  It may take some time before the tree shows any folders, due to 
initialization of the tree.

Press Next to continue.

The last steps in the definition of a source type are the same for all types. 
They are described in section “Last steps in a source type definition“ on 
page 31.

Adding a MS Outlook file (PST, OST) source
Follow these steps to add an MS Outlook file (PST, OST) source to Intella:

1. Source Type
Start the Add New Source wizard from the menu: Sources > 
AddNew...
Select "MS Outlook file (PST,OST)" and press Next.

2. Specify File
Enter the location and name of the PST or OST file (pathname and 
file that you would like to investigate). 
Press Open to browse folders for PST or OST files.
Press Next to continue.

Tip:  In case you want to index e-mails of an Outlook installation on a 
computer, you will find the PST file in the following directory...

•Windows Vista: 
C:\Users\<username>\AppData\Local\Microsoft\Outlook

•Windows 2000, 2003 and XP: 
C:\Documents and Settings\<username>\Local Settings\Application 
Data\Microsoft\Outlook
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The last steps in the definition of a source type are the same for all types. 
They are described in section “Last steps in a source type definition“ on 
page 31.

Adding a MS Outlook Express DBX file source
Follow these steps to add an MS Outlook Express DBX file source to Intella:

1. Source Type
Start the Add New Source wizard from the menu: Sources > 
AddNew...
Select "MS Outlook Express DBX file" and press Next.

2. Specify File
Enter the location and name of the DBX file (pathname and file 
that you would like to investigate).
Press Open to browse folders for PST or OST files.
Press Next to continue.

Tip:  In case you want to index e-mails of an Outlook Express installation on a 
computer, you will find the DBX file in the following directory...

•Windows 2000, 2003 and XP: 
C:\Documents & Settings\<username>\Local Settings\Application 
Data\Identities\{<arbitrary string}\Microsoft\Outlook Express

The last steps in the definition of a source type are the same for all types. 
They are described in section “Last steps in a source type definition“ on 
page 31.
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Adding a Lotus Notes NSF file source

Important:  Please read the section "Lotus Notes configuration" on page 16 to 
prepare Intella for Lotus Notes NSF file sources.

Follow these steps to add a Lotus Notes NSF file source to Intella:

1. Source Type
Start the Add New Source wizard from the menu: Sources > 
AddNew...
Select “Lotus Notes NSF file” and press Next.

2. Specify File
Enter the location and name of the NSF file (pathname and file) 
that you would like to investigate.
Press Open to browse folders for NSF files.
Press Next to continue.

Tip:  In the case that you want to index e-mails of a Lotus Notes installation on 
a computer, you will find the NSF files in the following data directories...

•Version 7.x: C:\Program Files\Lotus\Notes\Data

•Version 8.x: C:\Program Files\IBM\Lotus\Notes\Data

The last steps in the definition of a source type are the same for all types. 
They are described in section “Last steps in a source type definition“ on 
page 31.

Adding an IMAP account source
Follow these steps to add an IMAP Account source to Intella:

1. Source Type
Start the Add New Source wizard from the menu: Sources > 
AddNew...
Select "IMAP account" and press Next.
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2. Specify Account
Enter the credentials of your e-mail account, e.g. “mail.my-
isp.com” with your username and password. Mark the checkbox if 
you want or need a secure connection to the mail server. This is 
recommended, abecause without a secure connection your 
password will be sent across  the Internet as plain text.
Press Next to continue.

3. Select Folders
In the next step Intella will contact your mail server to retrieve the 
mail folder tree. If you selected a secure connection and the server 
uses a certificate that cannot be validated automatically, an 
intermediate dialog will appear that asks you whether the 
certificate should be accepted.  When no security dialog appears or 
when you accept the certificate, Intella will eventually show the 
folder tree of your mail account. You can now check all folders that 
you want to make searchable. Note that subfolders that you want to 
make searchable need to be explicitly checked as such, otherwise 
they are ignored. The wizard sheet has two convenience buttons for 
selecting and deselecting all checkboxes at once.
Press Next to continue.

The last steps in the definition of a source type are the same for all types. 
They are described in section “Last steps in a source type definition“ on 
page 31.

Last steps in a source type definition
The following, last steps are the same for all source type defintions.

1. Size Limit
Specify the maximum allowable size for the files to be included. 
Any files larger than this size will be ignored. By default this limit is 
set to “Unlimited”, meaning that all files are accepted.
Use this threshold, for example, when you have  exceptionally large 
PDF files (in the order of tens of megabytes) on which Intella 
freezes during indexing.
Press Next to continue.
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2. Source Name
Next, you are requested to enter a name for the source. The name 
will be shown in the list of sources in the Sources panel and 
functions as a label for the  source.
Press Next to continue.

3. MD5 Hashes
Next, you are asked if Intella should calculate MD5 hashes for every 
item indexed. This will enable Intella to filter duplicates from the 
search results. It will however slightly increase the duration of the 
indexing process.
Press Next to continue.

4. Archives and Embedded Resources
Intella can index the files inside archives and extract the images 
inside documents. You can disable this, thereby improving 
indexing performance at the cost of less results. 
Unmark Index archives or Index image inside documents if you 
don't want to index archives or extract images inside documents.
Press Next to continue.

5. Image Cache
All images (BMP, JPEG, GIF, PNG) are cached for use in the 
Thumbnail viewer. You may optionally disable caching. This lets 
you save some disk space and increases indexing performance. This  
setting cannot be changed once the source has been defined.
Press Next to continue.

6. Completed Source Definition
Finally, you see a screen telling you that you have successfully 
defined a new source. You may optionally start indexing the source. 
This is required in order to be able to search and explore the files in 
this source. 

Tip:  As the active indexing process blocks the entire user interface, you may 
also decide to skip this part now (e.g. to define more new sources) and index 
the sources later by hitting the Refresh button. Once you click the Next button, 
the source will appear in the list in the Sources Panel and the indexing process 
will start, depending on the choice you have made.
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Note:  At any time except for the last step, you can press the Cancel button. 
Then no source will be added.

Indexing, refreshing and 
re-indexing sources

Indexing
After definition, Intella will index the source: it will inspect all items 
(e-mails, files etc.) that it can find in this source. This enables Intella to 
return instantaneous results during your exploration tot relevant evidence. 

The creation of the first index will take quite some time as the contents of 
each file is inspected for keywords and other valuable metadata. 
Subsequent indexing is typically much faster, as it only inspects new or 
changed files.

Note:  During indexing, you see a dialog telling you which file or other type of 
item is currently being processed, as well as some statistics. Usage of the 
application is blocked while this dialog is shown.

The statistics in this dialog reveal the number of new, changed, removed 
and unchanged items that Intella has found in the source(s) that are being 
indexed. Naturally, initial indexing will only find new items. Subsequent 
indexing will usually provide only a limited number of new, removed 
and/or changed items and a large number of unchanged items, but  this 
depends on the dynamic nature of the source. The processing overhead of 
unchanged and removed items is negligible, only new and changed items 
need full processing.

Please be aware of the fact that the numbers shown in the dialog count both 
files and folders, i.e. a folder with two files in it is counted as three items. 
This  explains why the number of scanned items may be higher than the 
number of items that can be found in the source afterwards.
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You can abort the index process at any time by pressing the Stop button. 
Intella will finish processing the current item and then let you close the 
dialog. When you press the refresh button again, incremental indexing will 
continue right where it left off, so your previous indexing is not lost.

Refreshing
Indexing usually takes place right after definition of the source. 
Furthermore, sources can be refreshed upon user request. A refresh will 
inspect the source for new, removed and changed items. This guarantees 
up-to-date search results.

When you decide not to index the source right after you have defined it, the 
creation of the initial index will take place when you issue a refresh.

The “Refresh all” option is available in the Sources menu and in the Sources 
panel in the lower left of the main window. Alternatively, you can refresh all 
sources with CTRL+R.

To refresh a single source, open the Source Editor (type CTRL+E), select 
the source and press the Refresh button below the list.

If you refresh one or more sources when query results were already 
displayed , these queries will be re-evaluated to represent the new state and 
the display will be re-drawn.

Re-indexing
If for some reason you suspect that the search results have become corrupt, 
you can always do a “Re-index”. Intella will remove all indexes that it had 
created and start to index all sources as if it is indexing them for the first 
time. 

The Re-index option that fully re-indexes all sources is available in the 
Sources menu. Alternatively, you can also fully re-index a single source by 
opening the Source Editor (type CTRL+E) and right-click on the source 
name. This opens a pop-up menu with a Re-index option for that particular 
source.

page 34 | Intella 7. Sources | © 2008-2009  Vound



Editing sources

The configuration of your sources can be changed at any time. Only the type 
of the source is fixed, all other information can be changed.

To edit the configuration of a source, go to Sources > Edit Sources... A 
window opens that shows the list of sources on the left.

Tip:  You can also open the Source Editor with the Edit Sources button in the 
Sources panel or press CTRL+E.

Below the list of sources are three buttons that let you add a new source, 
remove the selected source or refresh the selected source, respectively.

Right-clicking on a source in the list shows a popup menu that lets you 
remove the source or start a refresh or re-index of the source.

When you click on a source, its details are shown in the area to the right of 
the list. The name and type are shown as well as source type-specific details 
such as folders to index, file size restrictions, etc. See the section on Adding 
Sources above for the precise meaning of these settings per source type.
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Furthermore, each source has a check box labelled "Include this source 
when refreshing all sources" that is switched on by default. This check box 
determines the behaviour of the Refresh button and the menu item in the 
main window. When switched off, the source will not be refreshed when 
this button is pressed or menu item is selected, but can only be manually 
refreshed through this window. This may be practical for large sources that 
update rarely or for which you want to maintain the same state for a while.

When you change the source's configuration, the Apply button will become 
enabled. Only when you press Apply will the changes become effective. 
When the button is enabled and you select a different source or press the 
Close button, a dialog appears that asks whether you want to apply or forget 
the changes or cancel the operation.

When you close the window and changes have been made to one or more 
sources, Intella asks whether you want to refresh those sources. Depending 
on the nature of the change, it may for example be possible that some items 
within a source now fall within or outside the scope of the source whereas 
before they did not.

Selecting sources

In the sources panel you will see a list of sources 
scanned by Intella.

In the sources list, mark the sources you want to 
include in your search and unmark those that 
you want to exclude. New searches will be 
performed only on the marked sources.

Use "Check/uncheck all" check box to select or 
deselect all sources in the list.
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Shortcuts

The following source-related global keyboard shortcuts are available:

• CTRL+N starts the Add New Source wizard.
• CTRL+E opens the Edit Sources window.
• CTRL+R starts a refresh of all sources, excluding sources that were 

explicitly excluded from being refreshed in a global refresh.
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8. Searching

To search for a text, enter a query in the Search panel, and press the Search 
button.

For query syntax rules, refer to “Search query syntax” section below.

Search options

With search options you can limit keyword searching to specific item parts 
or attributes:

• Text
• Title / Subject
• Summary & Description (includes e-mail 

headers)
• Path & File name
• Authors & E-mail names
• Message Headers

To see the search options in the popup, press the 
Options button under the search text field. The 
options box will be displayed below the button.

Mark the options for properties that you want to include in your search, 
and unmark those you want to exclude. Your marked search options will be 
stored and used for future searches until you change them.

To hide the options box, press the Options button again.
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Limiting the search scope

To restrict searching to items from specific sources only, go to the Sources 
panel. In the sources list, mark the sources you want to search and unmark 
those that you want to exclude from searching. New searches will be 
performed only on the marked sources.

Use the “Check/uncheck all” check box to select or deselect all sources in 
the list.

Note:  Example: The window in the “Selecting Sources” section above shows 3 
marked sources.

Search query syntax

In the text item of the Search panel you can use special query syntax to 
perform complex multi-term queries and use other advanced capabilities.

Tip:  You can see the list shown below by pressing the question mark button in 
the Search panel.

Use of multiple terms (AND and OR operator)
By default, a query containing multiple terms matches with items that 
contain all terms anywhere in the item:

John Johnson

returns all items that contain both “John” and “Johnson”. You can be more 
explicit and add ANDs (or “&&”) to your query. They do not harm but they 
have no effect either.

If you want to find items containing at least one term but not necessarily 
both, use one of the following queries:

John OR Johnson
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John || Johnson

Minus sign (NOT operator)
The NOT operator excludes items that contain the term after NOT:

John NOT Johnson 
John -Johnson

Both queries return items that contain the word “John” and not the word 
“Johnson”.

John -“John goes home”

This returns all items with “John” in it, excluding items that contain the 
phrase “John goes home”.

Phrase search
To search for a certain phrase (a list of words appearing right after each 
other and in that particular order), enter the phrase within double quotes in 
the search box:

“John goes home”

would match with the text “John goes home after work” but would not 
match the text “John goes back home after work”.

Grouping
You can use parentheses to control how your Boolean queries are 
evaluated:

(desktop OR server) AND application

retrieves all items that contain “desktop” and/or “server”, as well as the 
term “application”.
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Single and multiple character wildcard 

searches
To perform a single character wildcard search you can use the “?” symbol. 
To perform a multiple character wildcard search you can use the “*” 
symbol.
To search for “next” or “nest”, use:

ne?t

To search for “text” or “teleport” use:

te*t

Fuzzy search
Intella supports fuzzy queries, i.e. queries that roughly match the entered 
terms. For a fuzzy search, you use the tilde (“~”) symbol at the end of a 
single term:

roam~

returns items containing terms like “foam”, “roams”, “room”, etc.

Proximity search
Intella supports finding items based on words that are within a specified 
maximum distance from each other in the items text. This can be seen as a 
generalization of a phrase search.
To do a proximity search you place a tilde (“~”) symbol at the end of a 
phrase, followed by the maximum word distance:

“desktop application”~10

returns items with these two words in it at a maximum of 10 words 
distance.

Field-specific search
Intella's Keyword Search searches in item texts, titles, paths, etc. By default, 
all these types of text are searched through. You can override this globally 
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by deselecting some of the fields in the Options, or for an individual search 
by entering the field name in your search.

title:intella

returns all items that contain the word “intella” in their title. 

The following field names are available:

text - searches in the item text
title - searches in titles and subjects
path - searches in file and folder names 
summary - searches in descriptions, metadata keywords, etc. 
agent - searches in authors and mail senders and receivers

You can mix the use of various fields in a single query:

intella agent:john

searches for all items containing the word “intella” (in one of the fields 
selected in the Options) that have “john” in their author metadata or e-mail 
senders and receivers.
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9. Using facets

Besides keyword searching, the indexed items 
can be browsed by facets, which represent 
specific item properties.

Every facet organizes the items into groups 
(possibly hierarchical) depending on a specific 
item property.

Selecting a facet in the Facet panel will give you 
a list of all values of the selected facet in the 
lower part of the panel. (In the example, the 
source facet has 4 values.) To search for items 
that match with a facet value, select the facet 
value and press the Search button or double-
click the facet value.

Keyword Suggestions

After at least one search is performed, Intella 
presents you with a list of terms, relevant to the 
results of search. You can use them to refine the 
initial query and thereby improve the search 
results.

To refine your query with a suggested term, 
select it in the Suggestions list, and press the 
Search button below the list.
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Tags

Tags are labels that describe individual items. Tags are defined by the user.

To refine your query with a tag, select a tag from the Tags list, and press the 
Search button below the list.

MD5 hash

Intella can calculate MD5 hashes to check the uniqueness of a file. If two 
files have the same MD5 hash, they are considered to be duplicates by 
Intella.

You can also let Intella search for files that have a specific MD5 hash. To do 
so, enter the  hash (32 hexadecimal digits) in the field and press the Search 
button.

Tip:  Install a free tool, like MD5 Calculator by BullZip, in order to calculate the 
MD5 hash of a file. The calculated hash can then be searched for in Intella. This 
enables you to decide if there are duplicates of the file indexed by Intella.

Source

In the source facet you will see a list of sources scanned by Intella.

To refine your query with a specific source, select the source and press the 
Search button.
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Location

This facet represents paths to the items inside 
their sources. In the case of a Folder source, 
each “Location” item represents a hierarchy of 
folders with the base source folder as a root.

To refine your query with a specific location, 
select the location and press the Search button.

Important:  The location facet does not search 
hierarchically. It only searches the files in the 
chosen location, not the subdirectories.

Date & time

This facet organizes the items into the following groups, depending on their 
last modified dates:

• Today
• Yesterday
• Past week
• Past month
• Past year
• Older than 1 year
• Custom Date Range

To refine your query with a specific date, select one of the values in the list, 
and press the Search button.

You can create a custom date range by 
pressing the Custom... button. Select a date 
range in the dialog and press the OK button. 
The date range is added as a result set in the 
details panel.
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Note: Custom date ranges cannot be stored.

Type

This facet represents the file types (HTML, MS Word, PDF, etc.), organized 
hierarchically.

To refine your query with a specific file type, select a type from the list and 
press “Search”.

People

This facet represents the names of people related with the items. The 
people are grouped into four categories:

• Sender (of e-mails)
• Receiver (of e-mails)
• Creator (of documents)
• Contributor (of documents)

To refine your query by a specific sender, receiver, creator or contributor, 
select the name and press the Search button.

Language

This facet shows a list of languages that are automatically detected in your 
items.

To refine your query with a specific language, select the language from the 
list and press the Search button.

Important: In the case that Intella cannot determine the language of an item, the 
item is classified as “Unidentified”.
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Size

Organizes the items depending on their physical file sizes.

To refine your query with a specific size range, select a value from the list 
and press the Search button.
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10. Cluster Map panel

The Cluster Map shows search results in a graphical way. Since the Cluster 
Map is a rather new way of presenting search results, this chapter helps you 
understanding it.

Understanding a Cluster Map

The figure above shows labels, clusters and items. The larger spheres are 
clusters. They represent groups of items. Clusters contain smaller spheres, 
that represent individual items, like e-mails and files. Parts of the query, 
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shown as labels, organise the map. Every cluster is connected to one or 
more labels.

Note:  The small yellow spheres represent locally available items: these items 
are available on the computer that runs Intella. The small blue spheres represent 
items that are remotely available: these items are kept on a server.

The figure above shows the Cluster Map after the user has evaluated a 
query with two parts: a keyword search for the term “application”, and a 
search for Documents using the Type facet. 

The Cluster Map holds two result sets, with the following labels:
• Documents (748): 748 items, bleu edges
• application (87): 87 items, red edges

The coloured edges rendered in the background connect items to labels, 
indicating that these items belong to that result set. An item contained in 
multiple result sets is displayed only once but connected to the labels of the 
sets that contain it. Example: the items in the middle cluster.

Note:  When a cluster contains more than 250 items, it is displayed as a single 
sphere labelled with the number of items. The individual items are hidden.  This 
prevents clusters with large number of items from disturbing the usability of the 
Cluster Map. 

Working with the Cluster Map

Removing result sets
The result sets created with the current query 
are listed in the box at the top right corner of 
the Cluster Map panel. To remove a result set 
from the Cluster Map, click on the remove icon 
(red X) in the list.

To clear the Cluster Map - remove all result sets - and start a new search, 
press the Clear button in the terms list.
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If the Cluster Map regeneration takes too long, you can stop the process by 
pressing the Stop button.

Opening a search result
Results can be opened in the viewer by double-clicking on their spheres in 
the graph. Results can also be opened in the Details panel, by double-
clicking on the row in table view, or by clicking on the title in list view.

Tip:  Details about individual results are shown in a tool tip that pops up when 
the user hovers the mouse pointer over an item in a cluster.

Export cluster map
You can export the current Cluster Map graph as a PNG image, HTML, or 
XML image map (used to publish the map on a web-page).

To export the Cluster Map, go to Export > Cluster Map... In the wizard 
dialog, select the desired export format and enter a file name.
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Using significant terms
When the user selects a cluster in the Cluster Map, statistical measures are 
used to determine relevant terms for this set. These terms are listed as 
suggestions in the Facet panel (see Keyword Suggestions) and can be used 
to narrow down the search. When no selection is made, the union of all 
result sets is used to determine the suggestions.

Note:  Significant terms for specific items are displayed either in the "Significant 
Terms" column of the Table view, or at a bottom line of a corresponding List 
view item. To refine your query by a specific significant term, click on the 
"Significant terms" column for a specific item and select the term in a drop-
down list. In the case of the List View mode, click on a term of interest.

Options

The Cluster Map options and settings can be accessed through the buttons 
in the Cluster Map toolbar.

• Display individual results / Display clusters as single 
visual entities 
These two buttons switch between two modes of cluster 
visualization. In the first mode, each individual item is shown as an 
individual visible item within a cluster. Hovering the mouse cursor 
over this item will show information about the item in a tooltip. If 
you do not need this much detail in the graph, you can use the 
second mode, in which individual items are not displayed within 
the clusters. When you click on a cluster, the detailed information 
is shown in the Details Panel.

• Change color scheme 
This button opens a menu to choose a scheme to colorize the 
clusters in the map. There are three color shemes:
• Result Based Colors (default): in which each query result set 

has its own color.
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• Rank Based Colors: in which the result set that matches the 
most queries has the darkest color. The lesser it matches, the 
lighter the color.

• Uniform Colors: where all results have the same color, until 
you make a selection, then the selections gets a darker color.

• Hide less connected clusters 
If this option is on, the clusters with fewer connections will be 
hidden.

• Scale the graph to fit the available screen space 
If the option is on, the cluster map size will be automatically 
adjusted for the screen space of the panel (no scrollbars will 
appear). This option can also be accessed through View > Cluster 
Map > Scale to fit window.
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11. Details panel

In order to inspect the contents of the visualization, the user can select a 
cluster or result set by clicking on it. Its contents will be displayed in the 
“Details” panel below the map. This panel contains a list of the items that 
can be presented in three modes:

• Table view
• List view
• Thumbnails view

Note: Switching display mode is done by pressing the button 
“Display results in a list”, the results will be shown in a list, with five 
results per page (configurable in the Preferences panel: File > Preferences). With 
the button “Display results in a table” you will switch to the table view of the 
results list. With the button “Display results as thumnails” you will switch to the 
thumbnail viewer.

Table view

Table view displays the results as a table where each row represents a single 
item and the columns represent the attributes such as title, date, location 
etc. (select the second button in the Details Panel Control). The set of 
attributes to display can be customized with “Toggle visible table columns” 
button (the right button of the Details Panel Control). Click on a table 
column header to sort the table by specific item attributes.
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Adding and removing columns
With the “Toggle visible table columns” button you can add and 
remove columns in the table by marking or unmarking column 
names in the popup menu. The selected columns are stored: every time you 
start Intella these columns will be shown until you select other columns.

This option is only available in the Table view.

The following columns are available:
• Location: Name of the location where the 

item is stored. This can be the name of 
directory in a file system or the name of an 
e-mail folder.

• Name: The file name of a document item. 
E.g. “meeting_notes.txt”.

• Title / Subject: The title of a document 
item or the subject of an e-mail item.

• Type: The item's type, like “MS PowerPoint 
Document” or “Email Message”.
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• MIME type: The type of an item according to the MIME standard.

• Size: The item's size in bytes.

• Date: The last modified date of an item.

• Significant Terms: The most important words in the text of an 
item. These words are calculated with statistical heuristics.

• Source: The name of the Intella source that holds the item.

• Language: The language of the item's text. If language is blank, 
the language could not be detected automatically.

• Creator: The name of the creator of a document item.

• Contributor: The name of the contributor of a document item.  

• Sender: The name of the sender of an e-mail item.

• Receiver: The name of the receiver of an e-mail item.

• URI: Uniform Resource Identifier that shows the link to an item.

• Has Children: Items that are marked to have children. Children 
are e-mail attachments, like documents and pictures.

• MD5 Hash: The MD5 hash code, that uniquely identifies the item.

• Copies: Show the number of copies of an item.

Reorganizing table columns
The columns can be reorganized by dragging a column header to a different 
location in the table.

Sorting the list
By clicking on a column header, the search results will be alphabetically, 
numerically or chronologically sorted.
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Deduplicating results
With the “Deduplicate results” button, 
duplicates are removed from the search results 
list based on the MD5 hashes of the results. The text next to the button 
informs you if duplicates are removed and if so how many duplicates are 
removed.

Note:  This option is only available in table view. 

Showing a conversation
Right click an e-mail item and select the option “Show 
conversation”. This will show a new result set in the 
Cluster Map - its label starts with “Conv: ....”- that shows 
all e-mail items that are part of the conversation, 
including replies and forwarded messages.

Note:  This option is only available in table view. 

Showing parent e-mail
Right click an e-mail attachment and select the option 
“Open parent email...” to view the e-mail message that 
contains the attachment.

Note:  This option is only available in table view. 

List view

List view displays the results in a form similar to conventional web search 
engines (select the third button in the Details Panel Control). For each item, 
the title and other important metadata are displayed. 

For your convenience, the list is split into separate pages.
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Thumbnails view

Thumbnails view displays the thumbnails of the images detected in a 
selected cluster. 

When you click a thumbnail, the image wil open in a separate tab.
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12.Tagging

When you select one or more items from the results table and open the pop-
up menu (right mouse click), you can tag these items by selecting “Tag”.

In the “Add Tags” dialog you can select already defined tags, or define a 
new tag with optional description. By pressing “OK” the marked tags are 
linked to the selected items.

The tag functionality is also available in the Cluster Map: right-click on a 
cluster or label and select “Tag...” from the popup menu.
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13. Exporting result list

When you right-click the table you can export the complete result of your 
search (including all the documents in the table) to a location (a file) by 
selecting “Export Result List” in the popup menu (also available in the 
menu: Export > Export Result List...). Select a location for the file in the file 
selector dialog and specify whether you want to create a report for this 
export. You must specify a file name and select a file type (RTF or PDF) and 
you can add a comment.

The report contains the date and time of the export and the comment. For 
every exported item the following information is included in the report: 
Link to object, Source, Location, ID, Type, and MD5.

The option Keep location structure, that will preserve the original folder 
structure during the export, will be enabled in a future version of Intella.

Note:  When there is a selection in the table, only the selected results will be 
exported, otherwise all results in the table will be exported.

page 59 | Intella 13. Exporting result list | © 2008-2009  Vound



Important:  If the export of a specific result resulted in errors, you will be 
notified with an error message in the application and you will find error 
notifications at the end of the report.

Exporting a single result

After selecting a file in the table, you can select “Export Result” in the 
popup menu (also available in the menu: Export > Result...). After 
specifying a location and a file name and pressing “Save”, the selected file 
will be exported.
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14. Viewing results

Overview of the viewer

When you double click on an item, it will open in a viewer as shown below. 
There are several tabs to browse the contents of an item. The tabs will 
differ, depending on the type of item you selected. The example below 
shows the tabs when an e-mail item is opened.

For text items, the Contents tab will show the text of the item. If you used 
search terms, they will be highlighted in the text. 
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Tabs

• Contents: This tab shows the body of  item.

• Headers: This tab shows the complete header of the e-mail item. 
This tab is only shown if you opened an e-mail item.

Important:  All the headers of the e-mails are indexed by Intella. You can 
search for words that are part of the e-mail headers only if you mark 
“Summary & Description” in the Search panel under Options (see 
Chapter 8 Searching).

• Properties: Shows a list of metadata properties.

• Attachments: List of all the attachments of the e-mail item. This 
tab is only shown if you opened an e-mail item.

• Thumbnails: Thumbnails of images (jpg, png, gif etc.) attached to 
the e-mail item or embedded in an item, like the images in a MS 
Word document.

• Advanced: Shows a complete metadata dump in RDF format.

Tip:  When you click a thumbnail, a new tab is added to the viewer. In this tab 
the image is shown.
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Buttons

• Previous and Next
With the Previous and Next buttons you open the previous or next 
items in the viewer. These buttons help to quickly inspect a result 
set.  

• Tag
This button opens the “Add Tags” dialog. Here you can add tags to 
the item. For more information see Chapter  section Tags and 
Chapter 12 section Tagging.

• Open
This buttons opens the item in a native application. E.g. a PDF-
item can be openend with Adobe Acrobat Reader. The 
configuration of your computer controls what application is started.

• Export...
This button opens a “Export result as” dialog. Enter a name and 
location if you want to store the item. For more information see 
Chapter  section  Exporting result list.
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15. Preferences

To open the preferences dialog, go to File > Preferences.

To apply changes of settings, press the Apply button. To apply changes and 
close the dialog box, press the OK button. The Cancel button will close the 
dialog box and discard all unapplied changes.

Below, the specific settings are explained.

General

Display splash screen
If this option is active, a splash screen will be displayed when Intella opens 
a case.
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Animate changes
If this option is active, changes in the Cluster Map image will be animated 
so that you can see how your Cluster Map changes when you add or remove 
a query. You can turn animation off, if it causes performance problems on 
your system.

Maximum duration
If the Cluster Map animation is active, this slider allows you to limit the 
duration of the animation.

Scale to fit window
If this option is active, the Cluster Map size will be automatically adjusted 
to the size of the panel (no scrollbars appear). 

You can also change this option using the Cluster map toolbar button, or go 
to View > Cluster Map > Scale to fit window.

Number of results per page
Define the number of items to be displayed on a single results page when 
the List View mode or the Details panel is used.

Thumbnail minimum size
This setting controls the minimum size of thumbnails in bytes. Decreasing 
the size results in less disk space usage, but can can have an impact on the 
visibility of the thumbnails.

MS Outlook

Preferred Outlook crawler
Here you can specify the crawler to be used for indexing PST and OST files. 
The Jpff setting is recommended, since it does not require installation of 
MS Outlook on the computer that runs Intella.
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If you make a choice for the other crawler, Rdo crawler, keep in mind that 
you need to have MS Outlook installed on the computer that runs Intella 
and check if Intella can find the MS Outlook binaries.  See section MS 
Outlook connector.

MS Outlook connector
To check if Intella can find the MS Outlook binaries, press Validate. The 
status is shown in the (non editable) field. If it fails, please consult your 
system administrator to make sure that MS Outlook is installed correctly.

IBM Lotus Notes

To check if Intella can find the Lotus Notes binaries, press Validate. The 
status is shown in the (non editable) field.

If it fails to validate, you should perform the following steps:

1. Go to File > Preferences and select the “IBM Lotus Notes” tab.

2. Press Browse in the “Lotus Notes Connector” section and select the 
path to the Lotus Notes directory. Press Apply.

Tip: The default installation directories for Lotus Notes are...

•Version 7.x: C:\Program Files\Lotus\Notes

•Version 8.x: C:\Program Files\IBM\Lotus\Notes

3. Restart Intella and go to Preferences > Data Source Connectors 
again.

4. Press “Add to PATH” in the “Lotus Notes Connector” section.

5. Now restart your computer.
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16. Menu and keyboard 
shortcuts

Main Menu

File
• Preferences

Open the Preferences dialog (see Preferences)

• Exit (Ctrl+Q)
Exit the application

Sources
• Refresh all (Ctrl+R)

Check all sources for updated (new, changed, deleted) items.

• Re-index
Re-create all indexes from scratch.

• Add new... (Ctrl+N)
Add a new source to be indexed by Intella.

• Edit sources... (Ctrl+E)
Open the Edit sources dialog box

For a detailed explanation of the source operations, please go to the 
Sources chapter.

View
• Cluster Map
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• Animate changes
Turn cluster map animation on or off
(see also: Preferences)

• Scale to Fit Window
Turn cluster map size scaling on or off
(see also: Preferences)

• Results
• List

Switch the Details panel view into the List Mode

• Table
Switch the Details panel view into the Table Mode

• Full screen
Toggle full-screen mode

Export
• Cluster Map...

You can export current cluster map graph as a PNG image, HTML, 
or XML image map (to publish the map on a web-page). In the 
wizard dialog, select desired export format and enter a file name.

• Result...
Export a single result to a desired location. See Chapter 11. Details
panel section “Export Result”.

• Result List...
Export all the files in a selection (or the entire table) to a desired 
location and optionally create a report about the export. See 
Chapter 11. Details panel section “Export Result List”.

• Load File...
Option only available in Intella Legal. Contact sales@vound-
software.com
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Help
• Help Topics (F1)

• About Intella
Shows a dialog with two tabs. The first tab contains the version 
number of Intella. The second tab contains system information.

Keyboard shortcuts

• Ctrl+R
Refresh all sources

• Ctrl+N
Add new source

• Ctrl+E
Edit sources

• Ctrl+Q
Exit the application

• F1
Open Intella help file (requires PDF-viewer, like Adobe Acrobat)
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17. Frequently Asked 
Questions

Where are Intella's data files located?
There is an Intella data directory in your home directory. The actual path to 
this directory depends on your platform.

• Windows Vista
C:\Users\<USERNAME>\AppData\Roaming\Vound\Intella

• Windows 2000, 2003, XP
C:\Documents and Settings\<USERNAME>\Application 
Data\Intella

Where can I find Intella log files?
Look at the logs subdirectory of Intella data directory (see the question 
above).

How is a file type determined?
Intella looks for certain binary markers (so-called magic numbers) that 
identify certain file types. When this detection process fails to produce a 
detected file type, we fall back to a list of known file extensions per file type. 
In the case of a non-standard (unknown) file extension, the file type cannot 
be determined.

Why are some characters ignored in search 
queries?
This is caused by what is called the analyzer: before an item can be indexed,  
the analyzer breaks down the text in order to determine the individual 
words used in it. This analyzer throws away whitespace characters, 
punctuation characters, etc. The same analyzer is also used to break down 
your query into the individual terms.
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As non-letters and non-digits are ignored, for example, the queries 
“searchterm”, “searchterm/” and “searchterm “ (with an extra space at the 
end) all end up being equivalent.

Why can't I index a PST file when I use the 

Rdo crawler?
The PST files need to be writeable in order to be indexed by Intella, because 
Outlook needs to be able to maintain the virtual filesystem information 
within the PST file.  As expected, the contents of the e-mails is not changed 
during indexation. 

To check file permissions of a PST file, please take the following steps:
a) Open a file explorer window.
b) Browse to the PST file.
c) Right click the file and select Properties from the popup menu.
d) Look for Attributes and unmark “Read-only”.

What to do with a License Error?
If you receive the following License Error or a similar one, please close 
down all HASP related programs (i.e. Encase, SMART)  and reinstall 
Intella.

What to do with "Code 27 HASP _TS_ 
DETECTED"?
If you receive the error ...
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"Unable to validate License, Cause: Running on a Terminal Server, Error 
Code 27 HASP _TS_ DETECTED", 

it may be because you are trying to use Intella via a remote desktop 
connection. Intella will only run via a RDP session with the dongle in place.

What you should know about the Intella trial 

license?
• The evaluation version runs under a HASP Software License, that 

gives you the opportunity to use Intella for 14 days.

• If you would like to continue using Intella after this period, you will 
need to buy a license. After buying the license you will receive a 
USB dongle. With the dongle you can continue using the version 
you already installed. 

• We cannot extend the 14 days evaluation peiod. The only way to 
continue using Intella will be to use a dongle.

• The evaluation version will not work in VMware without a dongle.

• The Intella evaluation version will not run over a RDP connection 
without the dongle.

• All other HASP protected software must be closed when installing 
Intella. (i.e. EnCase, ASR data).

• If you change the clock on your system the license will 
automatically expire. You will need a dongle to be able to use 
Intella after that.
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